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WSTĘP 

W niniejszym poradniku zostaną przedstawione informacje o tym jak przeglądać i pozyskiwać dane czujnika SLSTR 
(Sentinel-3) dla obszaru morza, korzystając z serwisów internetowych takich jak: CODA Eumetsat i Eumetsat Data 
Centre oraz jak przygotować je do dalszej pracy w GIS za pomocą oprogramowania SNAP.  

Czujnik SLSTR (Sea and Land Surface Temperature Radiometer) rejestruje promieniowanie w zakresie VNIR, SWIR 
oraz TIR. Do poziomu L2 dane przetwarzane są oddzielnie dla obszaru lądu i morza. Produkty dla obszaru morza, 
zawierające dane o temperaturze powierzchni morza dostępne są wyłącznie poprzez serwisy agencji EUMETSAT.  

PRZEGLĄDANIE I POBIERANIE DANYCH  

EUMETSAT CODA  I  CODAREP  

LOGOWANIE DO SERWISU  

Wpisz w przeglądarce adres serwisu: https://coda.eumetsat.int/. Zostaniesz przekierowany do strony logowania. 
W przypadku braku konta, należy je założyć klikając NEW USER – CREATE NEW ACCOUNT. Bez rejestracji 
i logowania nie jest możliwe korzystanie z funkcjonalności serwisu. Rejestracja jest bezpłatna i prosta – wymaga 
podania jedynie kilku informacji na temat użytkownika. Uzyskany login i hasło obowiązują we wszystkich 
serwisach EUMETSAT (CODA, CODAREP i DATA CENTRE). 

 

WYSZUKIWANIE DANYCH 

Serwis CODA pozwala na przeszukiwanie bazy danych na podstawie kilku kryteriów. Uwaga!!! W różnych 
przeglądarkach internetowych strona może wyglądać różnie. Przedstawione tu przykłady zostały przygotowane 
z wykorzystaniem Mozilla Firefox. 

https://coda.eumetsat.int/
https://archive.eumetsat.int/usc/
https://archive.eumetsat.int/usc/
https://coda.eumetsat.int/
https://coda.eumetsat.int/
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Definiowanie parametrów wyszukiwania najlepiej rozpocząć od zaznaczenia obszaru zainteresowania. W tym 
celu należy wybrać opcję Polygon (patrz czerwona strzałka u dołu na powyższym obrazie). Rysowanie poligonu 
odbywa się poprzez zaznaczanie na mapie punktów lewym klawiszem myszy. Aby zamknąć poligon i zakończyć 
rysowanie należy kliknąć prawym klawiszem myszy. Poligon zostanie podświetlony na żółto. Aby móc przesuwać 
mapę pozostawiając poligon, należy przejść do trybu Pan. Wyszukiwane będą wszystkie dane, które przynajmniej 
częściowo pokrywają zadany obszar. Aby ograniczyć dalej wyszukiwanie należy kliknąć ikonę po lewej stronie 
okienka Insert search criteria. Rozwinie się lista pozwalająca zdefiniować parametry przeszukiwania 
i wyświetlania wyników:  

Sortowanie (Sort By) - wybór sposobu sortowania wyszukiwanych obrazów:  

• Ingestion date - wg. daty „przyjęcia” danych (produktu) do bazy danych; 
• Sensing date – wg. daty wykonania zobrazowania; 
• Cloud Coverage – wg. stopnia pokrycia chmurami sceny 

Kierunek sortowania (Order by) – wybór kierunku sortowania wyników 

• Descending - malejąco 
• Ascending - rosnąco 

Okres (Sensing period/Ingestion period) – wybór dat w ramach, których użytkownik dokonuje wyszukiwania.  

UWAGA!!! W serwisie CODA udostępniane są dane do roku wstecz. Wcześniejsze dane, z okresu 19/04/2016 do 
04/04/2018 dostępne są w serwisie CODAREP (https://codarep.eumetsat.int/), do którego zalogować się można 
za pomocą tego samego loginu i hasła. Jego funkcjonalność jest taka sama jak opisana tu dla CODA. Dane 
zarejestrowane po 04/04/2018, które nie są już dostępne w CODA można pozyskać za pomocą EUMETSAT Data 
Centre (patrz następny rozdział). 

Następnie można zawęzić wyszukiwanie wypełniając informacje w jednym lub kilku następujących filtrach: 

• Instrument (Instrument)  
• Poziom przetworzenia (Product Level): 

o L0 – dane surowe 
o L1 – dane po korekcji instrumentalnej i geolokacji, radiacja i temperatura radiacyjna w kanałach 

spektralnych dla obu trybów rejestracji (nadirowej i ukośnej) 

https://codarep.eumetsat.int/
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o L2 – dane po korekcji atmosferycznej, temperatura powierzchni morza (skin temperature).  
• tryb udostępniania (Timeliness) - w przypadku SLSTR dane są udostępniane w 2 trybach 

o NRT (Near Real Time) – produkty udostępniane już w ciągu 3 godzin po rejestracji, ale mniej 
dokładnie przetworzone (w szczególności mniej dokładne dane georeferencyjne) – 
przechowywane w bazie do miesiąca od rejestracji 

o NTC (Non Time Critical) – produkty udostępniane z opóźnieniem do miesiąca po rejestracji, ale 
przeważnie już w ciągu 24-48h (algorytmy wykorzystują bardziej precyzyjne informacje do 
korekcji) -  przechowywane w bazie do roku od rejestracji 

i / lub bardziej szczegółowo: 

• produkt (Product type) – produkty czujnika SLSTR mają nazwy rozpoczynające się od „SL_”, następnie 1 
lub 2 oznacza poziom przetworzenia L1 lub L2, RBT – radiacja i temperatura radiacyjna, WST – 
temperatura powierzchni morza dla obszarów wody (produkt L2 dla obszaru lądu: SL_2_LST dostępny 
jest w serwisie Copernicus Access Hub) 

• numer cyklu (Cycle Number) – liczba wskazująca po raz który od początku misji satelita znalazł się 
dokładnie nad tym samym punktem na Ziemi (w trybie operacyjnym długość cyklu satelity Sentinel-3 
wynosi 27 dni) 

• numer orbity (Orbit Number) – liczba wskazująca kolejny obieg orbity od początku misji 
• numer ścieżki (Relative Orbit Start), czyli pasa zobrazowania odpowiadającego kolejnym obiegom 

satelity w jednym cyklu. 
• detected fire – pozwala na wybranie tylko tych scen, na których zidentyfikowano pożary 

W ćwiczeniu zostaną wykorzystane przykładowe dane z 14.06.2020. Aby pozyskać produkt L2 zaznacz poligon 
obejmujący Bałtyk, sortowanie po dacie rejestracji rosnąco, okres rejestracji od 14.06.2020 do 14.06.2020 oraz 
instrument SLSTR, tryb Non Time Critical, poziom przetworzenia L2. Pozostałe filtry pozostaw puste. Kliknij na 
lupę, aby uruchomić wyszukiwanie. 

 

Nastąpi wyszukiwanie scen, których choć część znajduje się w zadanym poligonie. W miejsce filtrów pojawi się 
lista znalezionych danych i obrysy ścieżek na mapie. 

http://www.scihub.copernicus.eu/
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POBIERANIE DANYCH 

Znajdź produkt L2 dla sceny zarejestrowanej ok. godz. 19, która obejmuje Bałtyk (możesz przeszukać listę albo 
klikając na mapie w obrys ścieżki obejmującej Bałtyk przejść do odpowiedniej pozycji listy). Klikniecie ikony View 
Product Details pozwala dokładniej przyjrzeć się przebiegowi ścieżki i szczegółom sceny 

 

 

Kliknij ikonkę Download product w oknie podglądu lub przy wybranym produkcie 
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Pojawi się okno zapisu. Wybierz ścieżkę i pobierz plik. Może to zająć kilka minut, z racji znacznej wielkości pliku. 
Plik jest w postaci spakowanego archiwum ZIP, które należy rozpakować. 

Więcej na temat funkcjonalności serwisu CODA w Sentinel 3 Marine Copernicus Data AccessUser Manual 

EUMETSAT DATA CENTRE  

LOGOWANIE DO SERWISU  

Dane SLSTR L2, które nie są dostępne w serwisie CODA można zamówić poprzez serwis Eumetsat Data Centre. 
Dotyczy to m.in. rejestracji porannych w trybie NTC oraz wszystkich rejestracji starszych niż 1 rok.  

Wejdź na stronę Eumetsat Data Centre (https://archive.eumetsat.int/usc/. Jeśli nie byłeś zalogowany wcześniej 
do innego serwisu Eumetsat lub sesja wygasła z powodu braku aktywności zostaniesz przekierowany do strony 
logowania. Zaloguj się za pomocą tego samego loginu i hasła jak w przypadku serwisu CODA.  

WYSZUKIWANIE DANYCH 

 

Po zalogowaniu wyświetli się powyższa strona. Krok po kroku użytkownik może dokonywać wyboru produktu za 
pomocą różnych filtrów. 

Products - umożliwia wybór spośród wielu produktów globalnych. Za pomocą Thematic Filter można ograniczyć 
listę produktów do tych zawierających potrzebne parametry. W zakładce Sentinel-3 DataSets dostępne są 
dodatkowo produkty tworzone dla określonych regionów. 

Aby pozyskać dane L2 odpowiadające tym pozyskiwanym z serwisu CODA dla trybu NTC wybierz filtr tematyczny 
Sea Surface Temperature, a następnie w zakładce Products: SLSTR Level 2 Sea Surface Temperature (SST) in NTC 
Sentinel-3. W okienku po prawej stronie pojawi się opis wybranego produktu. 

Kliknij NEXT STEP, aby przejść do następnej grupy filtrów, gdzie można ograniczyć wybór wg nazwy satelity 
(Satellite), statusu misji (Service Status, Overal Quality), ścieżki (Relative Orbit Number, Pass Number, Relative 
Pass Number), granuli (Frame Along Track Coordinate), trybu udostępniania danych (Timeliness) 

https://coda.eumetsat.int/manual/CODA-user-manual.pdf
https://archive.eumetsat.int/usc/
https://archive.eumetsat.int/usc/
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Aby zwiększyć zasięg wyszukiwania, zaznacz opcję All Satellites, która automatycznie zaznaczy nazwy obu 
satelitów: Sentinel 3A i Sentinel 3B. Są to satelity, o takich samych parametrach. Upewnij się, że wybrany został 
tryb NTC (Timelines). 

 

Kliknij NEXT STEP, aby przejść do zawężenia czasu rejestracji 

 

Ustaw zakres dat od 14.06.2020 godz. 08:00 do 14.06.2020 godz. 10:00, aby wyszukać poranne rejestracje. Kliknij 
APPLY przy dacie końcowej, aby zaakceptować ustawienia. W dolnej części okna pojawi się informacja o tym, ile 
produktów mieści się w zadanym oknie czasowym. 

W przypadku wyszukiwania porannych rejestracji z dłuższego okresu (kilku dni) zakres godzinowy należy podać 
w opcji Additional Filter.  

Kliknij NEXT STEP, aby przejść do zawężenia obszaru. 
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Obszar można zawęzić wybierając predefiniowany obszar w opcji Region lub definiując prostokąt ograniczony 
współrzędnymi geograficznymi zadanymi w opcji Upper left corner i Lower right corner. Prostokąt można 
również narysować na mapie myszką przytrzymując lewy klawisz myszy. Aby wielokrotnie korzystać ze 
zdefiniowanego regionu można zapisać go klikając SAVE REGION OF INTEREST. Tak zapisany będzie dostępny 
wraz z innymi regionami w opcji Region przy każdym następnym logowaniu do serwisu. 

 

Zdefiniuj obszar leżący między współrzędnymi 7.6° – 27.6°E oraz 52.8° - 67.3°N. Zapisz region do wykorzystania 
w przyszłości. Kliknij NEXT STEP, aby przejść do opcji wyboru formatu danych. Produkt SLSTR Level 2 Sea Surface 
Temperature (SST) in NTC Sentinel-3 dostępny jest wyłącznie w formacie Native. 

 

Kliknij NEXT STEP, aby przejść do wyboru sposobu dostarczenia danych. Wybierz Delivery Method: Online HTTP. 
Auxiliary data (dodatkowe dane metorologiczne) dołączane są niezależnie od wybranych opcji zgodnie z definicją 
standardowego produktu SLSTR Level 2 Sea Surface Temperature (SST) in NTC Sentinel-3. 

W dolnej części okna pojawi się informacja o tym, ile produktów ostatecznie spełnia zadane kryteria. 
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Kliknij DETAILS aby zobaczyć listę produktów. Po wybraniu produktu z listy wyświetlą się jego szczegóły i ścieżka. 
Wybierz jeden produkt, którego ścieżka najpełniej pokrywa Bałtyk. Usuń pozostałe za pomocą REMOVE 
UNSELECTED i zamknij okno podglądu produktów klikając CLOSE.  

 

W oknie wyboru metody dostarczenia danych zostanie zaktualizowana liczba i objętość produktów. Kliknij NEXT 
STEP, a w kolejnym oknie PLACE YOUR ORDER w celu złożenia zamówienia. Pojawi się okno ORDER STATUS z listą 
złożonych zamówień. Na adres mailowy podany podczas rejestracji zostanie przysłany mail potwierdzający 
złożenie zamówienia o numerze (Order ID) widocznym na liście zamówień. W przypadku braku maila należy 
sprawdzić folder SPAM (mail z adresu: noreply@eumetsat.int). 
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POBIERANIE DANYCH 

Przetworzenie danych przez Eumetsat Data Centre może potrwać od kilku minut do kilkunastu godzin. Po 
zakończeniu przetwarzania zostanie przysłany mail z informacjami o tym w jaki sposób można pobrać dane. 
Najprościej skorzystać z linku podanego w opcji „2) Using a browser”.  
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Dane spakowane są do pliku TAR. W przypadku zamówienia większej liczby produktów dane mogą być 
spakowane do kilku plików. Uwaga !!! dane dostępne są przez 7 dni od ich przetworzenia. W celu pobrania pliku 
należy kliknąć na jego nazwie, a następnie wybrać opcję Zapisz plik i folder docelowy.  

W celu rozpakowania archiwum można skorzystać np.  z darmowego programu 7Zip.  

 

 

STRUKTURA DANYCH SENTINEL-3 / SLSTR 

Po pobraniu danych z serwisu CODA lub Eumetsat Data Centre, należy rozpakować ich zawartość zachowując 
oryginalną nazwę spakowanych folderów. Dla pobranych przykładowych produktów będą to: 

• S3A_SL_2_WST____20200614T193628_20200614T211728_20200616T061947_6059_059_227______
MAR_O_NT_003.SEN3 (produkt pobrany z serwisu CODA) 

• S3B_SL_2_WST____20200614T085105_20200614T103205_20200615T195433_6059_040_078______
MAR_O_NT_003.SEN3 (produkt dostarczony przez Eumetsat Data Centre) 

W nazwie folderów rozpakowanych z plików zakodowane są informacje o produkcie: 

• S3A / S3B – Satelita, który dostarczył danych – w przykładzie rejestracja wieczorna z Senitnel-3A, 
rejestracja poranna z Senitnel-3B; 

• SL – Sensor SLSTR 
• 2 - poziom przetworzenia L2 
• WST – produkty termalne dla obszarów wodnych (water surface temparature) 
• 20200614T193628 / 20200614T085105 – czas początku rejestracji granuli (pierwsza linia) – 14 czerwca 

2020 roku godzina 19:36:28 / 08:51:05 
• 20200614T211728 / 20200614T103205 – czas końca rejestracji granuli (ostatnia linia) – 14 czerwca 2020 

roku godzina 21:17:28/ 10:32:05 
• 20200616T061947 / 20200615T195433– czas utworzenia produktu – 16 czerwca 2020 roku godzina 

06:19:47/ 15 czerwca 2020 roku godzina 19:54:33  
• 6059 – czas rejestracji całej sceny w sekundach 
• 059 / 040 – nr cyklu 
• 227 / 078 – nr ścieżki (numer orbity w cyklu) 
• _____ – nr granuli wzdłuż ścieżki, brak numeru oznacza całą ścieżkę 
• MAR (Marine Processing and Archiving Centre) – ośrodek przetwarzający dane 
• O – faza operacyjna działania satelity (R – w przypadku reprocessingu danych) 
• NT – tryb: non time critical 
• 003 – nr wersji przetwarzania (baseline collection) 

Struktura folderów jest taka sama, niezależnie od serwisu, z którego dane zostały pozyskane. Zawierają one: 

• Plik „xfdumanifest.xml” zawierający metadane i opis struktury produktów 
• Plik z danymi rastrowymi w formacie netCDF (*.nc), zawierający dane  
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Zestaw danych produktu SL_2_WST (zawartość pliku nc): 

• współrzędne pikseli (lat, lon)  
• temperatura powierzchni morza (skin temperature) wyznaczana najlepszym algorytmem 

(sea_surface_temperature) 
• statystyki błędów (Single Sensor Error Statistic): średni i odchylenie standardowe (sses_bias, 

sses_standard_deviation) 
• różnica aktualnej wartości SST w pikselu i ostatniej wartości referencyjnego produktu OSTIA L4 SST 

analysis (dt_analysis) 
• czas rejestracji piksela w sekundach (sst_dtime) od czasu referencyjnego sceny (time) podanego w 

metadanych (time+sst_dtime = czas rejestracji piksela w sekundach od 01.01.1981 00:00:00) 
• flagi jakości danych (l2p_flags, quality_level) 
• dodatkowe parametry przydatne w interpretacji wartości SST z modelu ECMWF: prędkość wiatru na 

wysokości 10 m (wind_speed), procentowe pokrycie piksela lodem (sea_ice_fraction) oraz indeks 
wpływu aerozoli na sygnał w pikselu oparty na definicji AATSR Saharan Dust Index 
(aerosol_dynamic_indicator) i ich różnica w czasie w stosunku do danych satelitarnych 
(wind_speed_dtime_from_sst, sea_ice_fraction_dtime_from_sst, adi_dtime_from_sst) 

• temperatura radiacyjna na górnej granicy atmosfery oraz temperaturowy ekwiwalent szumu 
w 3 kanałach spektralnych: S7, S8, S9 (brightness_temperature, nedt) 

• algorytm wykorzystany do obliczenia SST w każdym pikselu (sst_algorithm_type) 
• różnica wartości SST obliczonych na podstawie obu spojrzeń i tylko nadirowego dla pikseli w części 

ścieżki skanowanej podwójnie (dual_nadir_sst_difference) 
• teoretyczne niepewności (sst_theoretical_uncertainty, nadir_sst_theoretical_uncertainty) 
• prawdopodobieństwo pokrycia chmurami piksela (Bayesian cloud detection algorithm) dla obu 

spojrzeń: nadirowego i ukośnego (probability_cloud_single_in, probability_cloud_single_io) 
• kąt zenitalny satelity w momencie rejestracji piksela (satellite_zenith_angle) 

Wszystkie wartości temperatury są w Kelvinach. Dane oznaczone kolorem zielonym udostępniane są na razie 
eksperymentalnie.  

Więcej informacji na temat algorytmów przetwarzania danych SLSTR i ich produktów w serwisie Sentinel Online 

  

https://earth.esa.int/web/sentinel/technical-guides/sentinel-3-slstr
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WSTĘPNE PRZETWARZANIE DANYCH W PROGRAMIE SNAP 

Do dalszej części ćwiczeń wykorzystane będzie bezpłatne oprogramowanie SNAP. Możliwość pobrania 
oprogramowania na stronie http://step.esa.int/main/download/snap-download/. Do przeprowadzenia 
zaprezentowanych tu analiz wystarczy zainstalować pakiet narzędzi dla satelitów Sentinel (Sentinel Toolboxes). 
Na stronie http://step.esa.int/main/doc/tutorials/ znajdują się krótkie tutoriale omawiające podstawowe 
funkcje programu. Po uruchomieniu programu główne okno oraz zawartość menu i paska narzędzi może 
wyglądać różnie, w zależności od zainstalowanego zestawu tollboxów. W przypadku, gdy jakieś okno narzędzi 
wykorzystywanych w ćwiczeniu nie jest widoczne można je otworzyć za pomocą polecenia View > Tool windows. 

WYŚWIETLANIE DANYCH  

Aby wczytać dane satelitarne należy wybrać polecenie File > Open Product, następnie w oknie dialogowym 
przejść do folderu, do którego dane zostały rozpakowane, wskazać plik xfdumanifest.xml i kliknąć Open.  

Uwaga!!! Podczas rozpakowywania danych Sentinel-3 należy zachować oryginalną nazwę folderu. Dla 
analizowanego przykładu (dane z serwisu CODA) jest to: 

S3A_SL_2_WST____20200614T193628_20200614T211728_20200616T061947_6059_059_227______MAR_O_
NT_003.SEN3  

 

Program SNAP automatycznie wczyta plik *.nc zawarty w folderze produktu. Strukturę produktu możemy 
podejrzeć w oknie Product Explorer (otwarty przeważnie w lewej górnej części okna programu SNAP). Zawartość 
rozwija się przez kliknięcie w znak  po lewej stronie nazwy produktu i każdego z zawartych w nim folderów. 
Przykładowo: dane z kanałów spektralnych IR (wartości temperatury radiacyjnej na górnej granicy atmosfery) dla 
spojrzenia nadirowego znajdują się w folderze Bands > brightness_temperature (channel 1 = S7, channel 2 = S8, 
channel 3 = S9); współrzędne pikseli w warstwach rastrowych lat i lon; obliczone wartości temperatury 
powierzchni morza w sea_surface_temperature. 

http://step.esa.int/main/download/snap-download/
http://step.esa.int/main/doc/tutorials/
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Aby wyświetlić dane temperatury należy dwukrotnie kliknąć raster sea_surface_temperature. W oknie 
wyświetlania zostanie wyświetlony raster w odcieniach szarości. Dane SL_2_WST w trybie NTC często są 
udostępniane dla całej ścieżki, a nie dla wybranych granul, tak jak to jest w przykładzie. Stąd bardzo wąski i długi 
raster (1500 kolumn × 40394 wierszy). Przebieg ścieżki można prześledzić w oknie World View (zwykle jedna 
z zakładek w oknie poniżej Product Explorer). Bałtyk znajduje się nieco powyżej środka ścieżki. Przybliż ten obszar 

korzystając z narzędzi Zooming Tool  i Pan Tool  z paska narzędzi Tools. Obszar Europy rejestrowany był 
podczas lotu satelity z południa na północ, stąd odwrócony obraz (obraz wyświetlany jest od góry – pierwsza 
linia, w dół – ostatnia linia). W oknie Navigation można obrócić obraz podając kąt obrotu 180°. 

 



15 | S t r o n a  
 

Poruszając się kursorem w oknie wyświetlania na pasku stanu u dołu okna można podejrzeć współrzędne 
geograficzne wskazywanych pikseli lub współrzędne rastrowe (X - nr kolumny, Y – nr linii). Obszar Bałtyku mieści 
się mniej więcej pomiędzy liniami: 15500 – 18000.  

 

W oknie Pixel Info oprócz pozycji wskazywanego piksela można podejrzeć również wartość piksela, tu 
temperaturę powierzchni morza w Kelvinach oraz rozkodowane wartości flag (true / false dla różnych stanów). 
Dane SL_2_WST w obszarze lądu mają wartości kodowane jako „brak danych”. Piksele lądowe wyświetlane są 
kolorem tła okna, a wartość podawana jest jako NaN. Podobnie „maskowane” są inne obszary, gdzie nie można 
obliczyć wartości SST. W oknie Colour Manipulation widoczny jest histogram wartości SST oraz podstawowe 
statystyki, obliczane dla całego rastra, z pominięciem wartości NaN. Aby uzyskać wartości dla wybranego 
podobszaru należy utworzyć subset, czyli podzbiór zawierający tylko część oryginalnych danych. 

 

Wartość temperatury w Kelvinach podawana jest z dokładnością do 0,01K. W celu zmniejszenia rozmiaru plików 
dane zapisane są jako wartości całkowite (RAW). Program SNAP w sposób dynamiczny konwertuje je do wielkości 
geofizycznych (tu SST) zgodnie z formułą: 

𝑆𝑆𝑆𝑆𝑆𝑆 = 𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓𝑓 ∙ 𝑅𝑅𝑅𝑅𝑅𝑅 + 𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜𝑜 
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Zastosowanie innego oprogramowania do czytania i analizy danych SL_2_WST może wymagać samodzielnego 
przeliczenia wartości RAW. Scaling factor i offset można odczytać za pomocą funkcji Analysis > Information. 

 

 

PRZYGOTOWANIE MAPY SST 

W celu przygotowania mapy temperatury powierzchni morza należy dokonać projekcji danych do odwzorowania 
kartograficznego. Aby skrócić obliczenia można wcześniej ograniczyć dane do obszaru obejmującego Bałtyk 
tworząc subset.  W dalszych krokach można wykorzystać flagi do wymaskowania pikseli zachmurzonych lub tych 
o niskiej jakości danych oraz przeliczyć wartości temperatury do °C. Tak przygotowane dane można 
wyeksportować do dalszej pracy w GIS lub zastosować odpowiednią paletę barw i zapisać jako obraz do 
wykorzystania w prezentacji. 

WYCINANIE PODOBSZARU  

Do utworzenia podzbioru, zawierającego tylko część oryginalnych danych (tu wszystkie dane ograniczone do 
obszaru obejmującego Bałtyk) w programie SNAP służy funkcja Raster > Subset.  Pozwala ona utworzyć podzbiór 
zarówno zawężając obszar (Spatial Subset), jak i zawartość zbioru danych:  

• spektralnych i wyznaczonych na ich podstawie parametrów geofizycznych, danych geolokacji, flag, 
masek (Band subset) 

• dodatkowych danych (auxiliary data), które mogą być wykorzystane do dalszych korekcji i interpretacji 
(Tie-Point Grid Subset) 

• metadanych (Metadata Subset) 

Ograniczenie przestrzenne zbioru danych może odbywać się poprzez zadanie zakresu linii i kolumn (zakładka Pixel 
Coordinates) lub współrzędnych geograficznych (zakładka Geo Coordinates). 

Ogranicz zbiór danych przestrzennie do linii (Y) 15500 – 17999. Pozostaw wszystkie dane rastrowe (Band), dane 
dodatkowe (Tie-Point Grid) oraz metadane. 
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W oknie Product Explorer powstanie kolejny produkt zawierający 
wybrany podzbiór danych. Właściwie jest to produkt wirtualny, 
zawierający tylko odpowiednie definicje, których uruchomienie 
powoduje wczytanie określonych danych z produktu oryginalnego.  
Dlatego oryginalny produkt musi pozostawać nadal otwarty 
w Product Explorer. Zamknij wyświetlany raster 
sea_surface_temperature i otwórz go ponownie, ale korzystając 
z nowego produktu (subset_1_*), obróć obraz o 180°.  Zauważ, że 
w oknie Colour Manipulation zmienił się kształt histogramu wartości 
SST i statystyki.  

 

Jeżeli nie jest konieczne przedstawianie danych w postaci mapy w odpowiednim odwzorowaniu można bardziej 
zawęzić obszar danych i pominąć kolejny krok (projekcję) przechodząc od razu do maskowania pikseli. Aby wyniki 
kolejnych operacji zostały zapisane na dysku, warto zapisać wcześniej subset w formacie BEAM-DIMAP za 
pomocą opcji File > Save Product. Zamknąć oba produkty w oknie Product Explorer, a następnie otworzyć z dysku 
produkt zapisany w formacie BEAM-DIMAP. Aby zamknąć analizowany produkt w programie SNAP należy kliknąć 
prawym klawiszem myszy na jego nazwie w oknie Product Explorer, a następnie wybrać opcję Close Product. Aby 
otworzyć produkt w formacie BEAM-DIMAP należy wybrać File > Open Product, następnie w oknie dialogowym 
przejść do folderu, do którego dane zostały zapisane, wskazać plik NazwaProduktu.dim i kliknąć Open. więcej na 
temat formatu BEAM-DIMAP w następnym podrozdziale. 
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PROJEKCJA DO ODWZOROWANIA KARTOGRAFICZNEGO  

Kształt i położenie Bałtyku na obrazach SENTINEL-3 zależy od kierunku lotu satelity (ścieżki), ze względu na to, że 
dane nie zostały poddane projekcji do żadnego odwzorowania. Udostępniane są w siatce instrumentalnej (po 
korekcji zniekształceń geometrycznych wynikających z charakterystyki czujnika). Utrudnia to porównywanie 
obrazów rejestrowanych w różnym czasie, dlatego przed dalszymi etapami wizualizacji warto dane poddać 
projekcji. W programie SNAP służy do tego funkcja Raster > Geometric Operations > Reprojection. 

W zakładce I/O Parameters wybierz: 

• utworzony wcześniej subset jako produkt poddawany reprojekcji 
• podaj nazwę produktu, który powstanie po projekcji 
• wybierz zapis w formacie BEAM-DIMAP 
• podaj ścieżkę do folderu, w którym ma zostać zapisany produkt po projekcji 
• zaznacz opcję Open in SNAP, aby program wczytał automatycznie dane po projekcji 

   

Funkcja reprojekcji pozwala zapisać wynikowy produkt w różnych formatach. Format BEAM-DIMAP jest wygodną 
formą zapisu podczas pracy w SNAP, ponieważ pozwala na zapisywanie wraz z danymi również wybranych palet 
barwnych do wizualizacji, ustawień kontrastu, właściwości dodawanych pinezek itp. 

W zakładce Reprojection Parameters należy wybrać odwzorowanie do jakiego zostanie przeprowadzona 
projekcja, zdefiniować siatkę rastrową w wybranym odwzorowaniu oraz wybrać metodę resamplingu. 

Wybór odwzorowania może odbywać się na 3 sposoby: 

• zdefiniowanie własnego odwzorowania (Custom CRS) przez wybór DATUM, projekcji oraz zdefiniowanie 
właściwych dla danej projekcji parametrów 

• wybór spośród zdefiniowanych projekcji (Predefined CRS) 
• wskazanie innego produktu, którego odwzorowanie ma posłużyć jako wzorzec (Use CRS of) 

Produkt poddawany reprojekcji 

Nazwa produktu wynikowego 
Format produktu wynikowego 

Ścieżka do folderu, w którym zostanie zapisany 
wynikowy produkt 



19 | S t r o n a  
 

  

Zdefiniowanie siatki rastrowej w wybranym odwzorowaniu może odbywać się na 2 sposoby: 

• automatycznie (zaznaczona opcja Preserve resolution) – program dopasuje granice siatki tak aby 
zmieścił się cały obszar danych z produktu wejściowego, a wielkość piksela tak aby odpowiadała średniej 
wielkości pikseli oryginalnych 

• ręcznie (odznaczona opcja Preserve resolution, zdefiniowanie parametrów siatki w opcji Output 
Parameters) – poniżej przedstawiono przykład definicji siatki w odwzorowaniu EPSG:3035, o wielkości 
piksela 1000x1000 m, obejmującej zaznaczony obszar Bałtyku (współrzędne lewego górnego i prawego 
dolnego rogu nowej siatki podano na mapce w układzie współrzędnych EPSG:3035 – kolorem 
czerwonym i wiersz/kolumna – kolorem niebieskim) 

 

Użytkownik może wybrać jedną z 3 metod resamplingu (obliczenia wartości piksela w nowej siatce): 

• Nearest – przypisanie wartości metodą „najbliższego sąsiada” 
• Bilinear – interpolacja wartości na podstawie 4 najbliższych pikseli 
• Bicubic – interpolacja wartości na podstawie 16 najbliższych pikseli (polecana przy dużej zmianie 

wielkości piksela w stosunku do obrazu oryginalnego) 
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Ponieważ nowa siatka może zawierać obszar leżący poza zasięgiem zobrazowania należy podać również wartość 
jaka będzie przypisana pikselom w takiej sytuacji w polu No-data value (może to być dowolna wartość, która nie 
występuje wśród wartości parametrów, np. -9999 lub NaN) 

Na potrzeby ćwiczenia w zakładce Reprojection Parameters wybierz: 

• Predefined CRS: EPSG:3035 – ETRS89 / LAEA Europe (posłuż się nr EPSG w okienku Filter aby ułatwić 
sobie wyszukanie odwzorowania) 

• Ręczną definicję siatki (Output Parameters), zgodnie z przykładem na rysunku powyżej 
• Resampling metodą najbliższego sąsiada 
• NaN jako kod braku danych 

Uruchom przetwarzanie przyciskiem RUN. Po pojawieniu się nowego produktu w oknie Product Explorer można 
zamknąć produkt zawierający subset przed projekcją i oryginalny produkt S3 L2 (w takiej kolejności). 

Uwaga!!! Po zamknięciu edytora parametrów i jego ponownym otwarciu np. dla poprawienia jakiegoś parametru 
należy definicję siatki wpisać jeszcze raz (każde pole), nawet jeżeli wyświetlają się wartości wpisane przez 
użytkownika. Funkcja ta ma błąd i ponowne otwarcie tego okna przed uruchomieniem obliczeń powoduje 
przyjęcie w obliczeniach wartości defaultowych. 

W exploratorze windows można podejrzeć strukturę plików zapisanych w formacie BEAM-DIMAP. 

 

Będzie to zawsze folder NazwaProduktu.data zawierający dane oraz plik NazwaProduktu.dim, w którym zapisana 
jest struktura danych. Plik DIM służy do otwarcia danych w SNAP. Nie należy zmieniać nazw ani usuwać części 
danych z poziomu exploratora windows – konieczne operacje należy wykonać w SNAP. 

WYKORZYSTANIE MASEK  

Wyświetl mapę temperatury powierzchni morza klikając dwukrotnie na warstwę rastrową 
sea_surface_temperature (w Product Explorer folder Bands > sea_surface_temperature). Powiększ maksymalnie 

cały obszar (opcja Zoom All  w oknie Navigation). 

Flagi jakości danych i wstępnej klasyfikacji można wykorzystać, aby zaznaczyć na mapie np. obszar lądu, obszar 
przykryty chmurami itp. Aby wykorzystać je na etapie wizualizacji należy rozwinąć okno Mask Manager 
(przeważnie jest ono zwinięte do zakładki po prawej stronie okna programu, jeśli brak takiej zakładki należy 
otworzyć je poleceniem View > Tool windows > Mask Manager). 

Aby piksele, dla których wartość wybranej flagi jest równa TRUE zostały przysłonięte półprzezroczystą warstwą 
określonego koloru należy zaznaczyć pole wyboru przy odpowiedniej masce, zdefiniować jej kolor i ewentualnie 
zmienić współczynnik przezroczystości. 

Zaznacz wyświetlanie następujących masek: 

• l2p_flags_land – półprzezroczysta, zielona 
• quality_level_cloud – ciemnoszara, nieprzezroczysta 
• quality_level_worst_quality – półprzezroczysta, czerwona 

Zauważ, że maska l2p_flags_cloud obejmuje jednocześnie piksele maskowane za pomocą quality_level_cloud 
i quality_level_worst_quality na granicy chmur. Algorytm detekcji zachmurzenia często błędnie identyfikuje 
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obszary silnych gradientów temperatury, które mogą występować np. podczas zjawiska upwellingu 
przybrzeżnego lub w rejonie rozpływu wód rzecznych jako chmury lub dane o najniższej jakości. Maska 
l2p_flags_land obejmuje piksele na lądzie wraz z wodami śródlądowymi. Dobór masek zależy od celu analizy 
i wizualnej oceny obrazu przed i po zastosowaniu maski. 

 

Wybrany zestaw masek może być chwilowo włączany / wyłączany za pomocą Layer Manager.  
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Warstwa maski przysłania określone piksele jedynie na etapie wizualizacji. Jeżeli konieczne jest wyeliminowanie 
wartości tych pikseli z dalszej analizy, można wykorzystać odpowiednie maski do zdefiniowania własności rastra  
Valid-Pixel. Aby przejść do własności rastra sea_surface_temperature kliknij prawym klawiszem myszy na jego 

nazwie w Produkt Explorer, a następnie wybierz Properties. Przyciskiem  w polu Valid-Pixel Expression rozwiń 
edytor wyrażeń logicznych. W wyrażeniach logicznych można stosować nazwy masek oraz operatory logiczne: 

• ! – nieprawda, że (not) 
• && - koniunkcja (and) 
• II – alternatywa (or) 

Aby „usunąć wartości” z pikseli w obszarze lądu (l2p_flags_land) oraz w obszarze zachmurzonym 
(quality_level_cloud) jako Valid-Pixel należy wskazać te, które nie są objęte żadną z tych masek: 

! l2p_flags_land && ! quality_level_cloud 

  

Piksele niespełniające tego warunku traktowane będą przez program jak oznaczone kodem braku danych. 

Wpisz warunek, a następnie zatwierdź przyciskiem OK i zamknij okno właściwości warstwy rastrowej. Wyłącz 
chwilowo wyświetlanie masek aby zauważyć różnicę na obrazie. Piksele w obszarze lądu (wraz z wodami 
śródlądowymi) oraz w obszarze zachmurzonym powinny być wyświetlone kolorem tła okna. W oknie Pixel Info 
wartość w tych pikselach będzie podawana jako NaN co oznacza, że nie będą brane pod uwagę w żadnych 
analizach (np. przy tworzeniu histogramu widocznego w oknie Colour Manipulation).  

PRZELICZENIE SST DO °C I WIZUALIZACJA MAPY TEMPERATURY  

Obliczenia w programie SNAP można wykonać za pomocą kalkulatora rastrowego (przeliczenie oddzielnie 
każdego piksela zgodnie z tą samą formułą) dostępnego w Raster>Band Maths. W oknie funkcji należy wskazać 
produkt (Target Product), do którego zostanie zapisany tworzony raster (w folderze Bands) oraz podać jego 
nazwę. Uwaga !!! w nazwach rastrów, produktów oraz ścieżek nie używać polskich liter, znaków specjalnych oraz 
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spacji. Pola Description, Unit oraz Spectral wavelength są opcjonalne. Tworzony raster może zostać zapisany 
w dwojaki sposób: 

• jako raster wirtualny (zaznaczona opcja Virtual) – program SNAP zapisze jedynie formułę, a wartości 
pikseli będą obliczane dynamicznie podczas wyświetlania rastra lub jego dalszego przetwarzania – opcja 
polecana jedynie, gdy wynikowy raster będzie wykorzystywany tylko w SNAP i znajduje się w tym samym 
produkcie, co dane źródłowe wskazane w formule obliczeniowej 

• jako raster statyczny (odznaczona opcja Virtual) – program SNAP obliczy i zapisze na dysku wartości 
pikseli – opcja polecana, gdy wynikowy raster obliczany na podstawie danych z różnych produktów lub 
gdy będzie eksportowany do pracy w GIS 

  

Jeśli w źródłowych rastrach część pikseli oznaczona jest kodem braku danych (również te eliminowane za pomocą 
Valid-Pixel Expression), to w wyniku obliczeń zostaną one również oznaczone kodem braku danych. W przypadku 
dalszego eksportu wynikowego rastra, warto zastąpić standardową wartość NaN, wartością liczbową, która nie 
występuje wśród „dobrych” danych, np. -999.0 w przypadku temperatury w °C (programy GIS nie zawsze 
pozwalają na przetwarzanie danych zawierających wartości NaN). 

Formułę obliczeniową należy wpisać w polu Band maths expression korzystając z nazw rastrów źródłowych, 
masek lub flag, operatorów arytmetycznych i/lub logicznych oraz funkcji. W przypadku bardziej złożonych formuł 
można rozwinąć okno za pomocą przycisku Edit Expression, a następnie wybrać z listy odpowiednie dane 
źródłowe, operatory lub funkcje. Jeśli formuła wpisana jest prawidłowo, w prawej dolnej części okna pojawi się 
zielony napis„Ok, no errors. Klikając OK w oknie edytora wyrażeń matematycznych zatwierdzamy formułę.  
W oknie Band Maths można zapisać formułę, która ma być wykorzystywana wielokrotnie dla innych scen 
przyciskiem Save. Aby utworzyć wynikowy raster należy następnie wcisnąć OK. 

Utwórz raster statyczny o nazwie SST_C, będący wynikiem formuły przeliczającej wartości rastra 
sea_surface_temperature z K na °C. UWAGA !!! przeliczenia wartości RAW do SST w K nie uwzględnia się 
w formule – jest ono realizowane przez SNAP automatycznie. Jako kod braku danych w rastrze wynikowym 
wstaw wartość -999. Zapisz formułę na dysku do wykorzystania z kolejną sceną. 

Wartość sea_surface_temperature dla poszczególnych pikseli może być obliczana różnymi algorytmami. 
Informacja o tym jaki algorytm został wykorzystany w pikselu znajduje się w rastrze sst_algorithm_type, a 
wyjaśnienie co oznaczają numery algorytmów w   
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Algorytmy mają różną charakterystykę błędów, co można sprawdzić w rastrach sses_bias (błąd systematyczny) 
i sses_standard_deviation (błąd losowy). Błędy systematyczne generalnie nie różnią się znacznie, ale 
występowania lokalnie różnych zjawisk, np. mgły ponad upwellingiem przybrzeżnym może zwiększać błąd. W 
takim przypadku procedurę obliczeniową warto rozszerzyć aby uwzględnić błędy systematyczne: 

sea_surface_temperature – sses_bias – 273.15 

Ponieważ mapa błędów jest dodatkowo maskowana w obszarze zbyt dużych wartości tych błędów, pozwala to 
często poprawić maskowanie obszarów zachmurzonych, ale podobnie jak w przypadku samej maski chmur, 
może prowadzić do przemaskowania obszarów silnych gradientów. 

W dalszych etapach ćwiczenia pokazano wyniki bez uwzględnienia odejmowania błedów systematycznych. Dla 
porównania wyników wykonaj obliczenia w obu wersjach. 

Wejdź do właściwości utworzonego rastra (znajdź go w folderze Bands w oknie Produkt Explorer, kliknij prawym 
klawiszem myszy na jego nazwie, a następnie wybierz Properties). Zauważ, że pole Valid-Pixel Expression jest 
puste (piksele niespełniające warunku w produkcie źródłowym otrzymały kod braku danych), a kodem braku 
danych jest podana wartość -999. Typ danych to float32 (zmiennoprzecinkowe). 

 

Jeśli mapa SST_C nie wyświetliła się automatycznie, kliknij dwukrotnie nazwę rastra w oknie Produkt Explorer, 

aby ją wyświetlić w oknie wyświetlania. Powiększ maksymalnie cały obszar (opcja Zoom All  w oknie 
Navigation). 

W oknie Colour Manipulation wyświetlony jest histogram 
wartości pikseli (z pominięciem oznaczonych jako brak 
danych) oraz informacje o zakresie wartości i jednostce. 
Skala barwna informuje jednocześnie jakimi odcieniami 
szarości reprezentowane są różne zakresy wartości. 
Ukośna biała linia na histogramie wskazuje w jakim 
zakresie rozłożone są liniowo odcienie o nr 1-254. Odcień 
o nr 0 (tu kolor czarny) przypisany jest do wartości poniżej 
tego zakresu, a odcień nr 255 (tu kolor biały) do wartości 
powyżej.  
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W oknie tym można zmienić paletę barwną oraz dopasować rozkład wybranych barw do zakresu najczęściej 
występujących wartości.  

 Przejdź do trybu Editor: Basic, rozwiń listę palet 
(Colour ramp) i wybierz paletę o nazwie 
spectrum. Jeżeli takiej palety nie ma na liście 
skorzystaj z opcji importu palety: 

 

 
Palety znajdują się w folderze:  C:\Users\Name\.snap\auxdata\color_palettes 
Wybierz zakres wartości jakie ma obejmować paleta: 0-20.  

Wróć do trybu Sliders. Kliknij prawym klawiszem 
myszy między dwoma wybranymi znacznikami 
na skali barw i wybierz opcję Add new Slider aby 
dodać 9ty znacznik. Rozłóż znaczniki 
barw na skali równomiernie . 
Zapisz zmodyfikowany produkt za pomocą 
polecenia File > Save Product. 

 

 

EKSPORT OBRAZU LUB DANYCH 

Utworzoną mapę można zapisać w postaci pliku graficznego, aby umieścić go np. w raporcie. W tym celu należy 
kliknąć prawym klawiszem myszy na mapie i z menu kontekstowego wybrać opcję Export View as Image. W oknie 
dialogowym eksportu należy wybrać docelowy folder oraz format zapisu (dostępne: BMP, PNG, JPEG i TIFF). 
W prawej części okna dialogowego można zmienić rozdzielczość zapisywanego obrazu, a także zdecydować 
o zapisaniu całego obrazu (Full scene) zamiast widocznego fragmentu (View region).  

 

Wybór całego obrazu (Full scene) i pełnej rozdzielczości (Full resolution) pozwala na zapis obrazu 3 kanałowego 
dodatkowo w formacie GeoTIFF, wraz ze współrzędnymi, który można wykorzystać w GIS. Wartości pikseli nie 
odpowiadają jednak wartościom temperatury, pozwalają jedynie na odtworzenie w GIS podobnych barw.  
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Aby wyeksportować skalę barwną z opisem wartości należy ponownie kliknąć prawym klawiszem myszy na mapie 
i z menu kontekstowego wybrać opcję Export Colour Legend as Image. W oknie dialogowym eksportu należy 
wybrać docelowy folder oraz format zapisu (dostępne: BMP, PNG, JPEG i TIFF). W prawej części okna 
dialogowego przycisk Properties pozwala przejść do okna definiowania wyglądu legendy (nagłówek, orientacja 
pozioma lub pionowa, wielkość czcionki opisów itp.). Przycisk w oknie parametrów pozwala podejrzeć efekt 
końcowy. 

 

  

 

 

Zapisz całą mapę temperatury powierzchni morza (SST_C) jako obraz PNG w rozdzielczości w jakiej jest 
wyświetlany (View resolution). Zapisz skalę barwną jako poziomą legendę. Wstaw oba obrazy do dowolnego 
dokumentu. 

Aby wyeksportować dane do dalszych analiz (np. obliczanie 
statystyk temperatury, tworzenie wykresów zmian wzdłuż 
linii, porównanie z danymi mierzonymi in situ, itp.) należy 
wywołać funkcję File > Export, która pozwala 
wyeksportować dowolne rastry z produktu otwartego 
w oknie Product Explorer. Następnie należy wybrać format 
docelowego pliku. Najwygodniejszym jest przeważnie 
GeoTIFF. 

W oknie eksportu należy najpierw wybrać zestaw danych, 
które mają być wyeksportowane otwierając dodatkowe 
okno przyciskiem Subset znajdującym się po prawej stronie. 
Otwiera on kolejne okno o podobnej funkcjonalności jak to 
w funkcji Subset wykorzystanej wcześniej.  

Zestaw danych można ograniczyć ze względu na: 

• obszar (zakładka Spatial Subset)  
• warstwy rastrowe (Band subset) 
• metadane (Metadata Subset) 

Wybrany podzbiór należy zaakceptować przyciskiem OK. Następnie w oknie eksportu należy wybrać ścieżkę 
docelową i nadać nazwę eksportowanemu plikowi.  



27 | S t r o n a  
 

Wyeksportuj dane SST_C dla całego obszaru, bez metadanych. Nie eksportuj flag. 

. 

PORÓWNANIE DANYCH ZE SCENY PORANNEJ I WIECZORNEJ  

W programie SNAP dwie mapy temperatury (np. poranną i wieczorną) można porównać wizualnie 
wyświetlając je obok siebie w tej samej palecie barw, licząc statystyki wartości temperatur na obu 
mapach, tworząc mapę różnic albo wykres zależności. Te dwie ostatnie metody wymagają, aby obie 
mapy były w takiej samej siatce rastrowej, tzn. były w tym samym odwzorowaniu, obejmowały 
dokładnie ten sam obszar (zakres współrzędnych) i miały taki sam rozmiar pikseli. W celu 
porównania temperatur z rejestracji porannej i wieczornej należy dla sceny porannej powtórzyć te 
same etapy wstępnego przetwarzania danych, które wykonano dla sceny wieczornej, tj.: 

• reprojekcja do odwzorowania EPSG 3035 (wcześniejszy subset obszaru przyspieszy 
operację) 

• zastosowanie masek i przeliczenie temperatury do °C 
• zapisanie produktu z obliczonym rastrem SST_C w formacie BEAM-DIMAP 

Rozpakuj dane zawierające poranną rejestrację czujnikiem SLSTR (dane pozyskane z serwisu 
Eumetsat Data Center) 

Uwaga!!! Podczas rozpakowywania danych Sentinel-3 należy zachować oryginalną nazwę folderu. 
Dla analizowanego przykładu jest to: 

S3B_SL_2_WST____20200614T085105_20200614T103205_20200615T195433_6059_040_078 

______MAR_O_NT_003.SEN3 

Otwórz dane w SNAP poleceniem File > Open Product wskazując plik xfdumanifest.xml 
z powyższego folderu. Wyświetl raster sea_surface_temperature. Zauważ, że dane dla obszaru 
Bałtyku zostały w tym przypadku zarejestrowane podczas lotu satelity z północy na południe. 
Obszar Bałtyku mieści się mniej więcej pomiędzy liniami: 22500 – 24500. 

AUTOMATYZACJA PROCESU PRZETWARZANIA DANYCH 

Program SNAP pozwala zbudować schemat przetwarzania danych złożony z kolejnych funkcji 
i uruchomić ich sekwencję jednym poleceniem. Ułatwia to przetwarzanie większej liczby danych wg 
podobnego schematu. 

Do stworzenia schematu służy funkcja Tools > Graph Builder. W górnym oknie funkcji standardowo 
dodane są dwie funkcje wejścia/wyjścia, tj. funkcja wczytania danych (Read) i zapisu wyników 
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(Write). Klikając prawym klawiszem myszy w wolnym obszarze tego okna można dodać (Add) kolejne funkcje. 
Klikając prawym klawiszem myszy na dodanej funkcji można ją usunąć (Delete).  

 

Aby zachować właściwą kolejność działań usuń blok funkcji Write, a następnie dodaj kolejno Subset i Resample 
z grupy Raster>Geometric, BandMaths z Raster oraz Write z Input-Output. Następnie klikając prawym klawiszem 
myszy w wolnym obszarze okna uruchom Connect Graph aby zdefiniować przepływ danych pomiędzy funkcjami. 

 

W dolnej części okna funkcji Graph Builder znajdują się zakładki odpowiadające poszczególnym blokom funkcji, 
w których należy podać parametry z jakimi funkcje mają być uruchamiane (podobnie jak przy uruchamianiu 
poszczególnych funkcji z menu, choć nie zawsze dostęna jest ich pełna funkcjonalność). 

W zakładce funkcji Read wybierz produkt, który ma być przetwarzany. 

 

W zakładce funkcji Subset zaznacz dane (Source Bands), które mają zostać przetworzone: 
sea_surface_temperature (SST w Kelvinach), l2p_flags i quality_level (wykorzystywane maski), oraz lat i lon 
(geolokacja) i ewentualnie sses_bias jeżeli błąd systematyczny będzie odejmowany. Jeśli nie mamy pewności, 
które dane będą potrzebne w dalszych funkcjach, można zaznaczyć wszystkie (wydłuży to nieco proces 
przetwarzania danych). Wybierz opcję Pixel Coordinates i podaj zakres wycinanych kolumn: X – nr początkowej 
kolumny (0), Width – liczba wycinanych kolumn (1500) oraz linii: Y – nr początkowej linii (22500), Height – liczba 
wycinanych linii (2000). 
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W zakładce funkcji Reproject wybierz odwzorowanie LAEA Europe (opcja Predefined CRS), odznacz opcję 
Preserve resolution i zdefiniuj parametry siatki analogicznie jak dla poprzedniej sceny (patrz rozdział Projekcja do 
odwzorowania kartograficznego). Odznacz opcję Reproject tie-point grids (brak tie-point grids, które nie zostały 
uwzględnione w funkcji Subset). Jako metodę resamplingu wybierz Nearest (metoda najbliższego sąsiada). 

 

Podczas przetwarzania wieczornej sceny „krok po kroku” po reprojekcji zastosowano maskowanie pikseli poprzez 
edycję właściwości (Properties) Valid Pixel rastra sea_surface_temperature. Niestety edycji właściwości rastra 
nie można zautomatyzować, stąd w tym przypadku maskowanie zostanie wykonane jednocześnie z przeliczeniem 
temperatury do °C, poprzez zastosowanie wyrażenia logicznego postaci: 

if (𝑣𝑣𝑣𝑣𝑣𝑣𝑣𝑣𝑣𝑣 𝑝𝑝𝑝𝑝𝑝𝑝𝑒𝑒𝑙𝑙) then (𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝 𝑠𝑠𝑠𝑠𝑠𝑠) else (𝑘𝑘𝑘𝑘𝑘𝑘 𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏𝑏 𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑ℎ) 

warunek valid pixel uwzględni tak jak poprzednio obie maski (patrz rozdział Wykorzystanie masek), w operacji 
przeliczenia zostanie wykorzystany raster sea_surface_temperature, a jako kod braku danych podobnie jak 
poprzednio zostanie wykorzystana wartość -999.0. 

W zakładce funkcji BandMaths podaj nazwę tworzonego rastra (Target Band), typ danych dla obliczanych 
wartości (Target Band Type), kod braku danych (No-Data Value) oraz wyrażenie logiczne uwzględniające 
maskowanie i przeliczenie wartości SST (Expression). Pole Band Unit jest opcjonalne. W przypadku bardziej 
złożonych formuł można rozwinąć okno za pomocą przycisku Edit Expression, a następnie wybrać z listy 
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odpowiednie dane źródłowe, operatory lub funkcje. Jeśli formuła wpisana jest prawidłowo, w prawej dolnej 
części okna pojawi się zielony napis„Ok, no errors. Klikając OK w oknie edytora wyrażeń matematycznych 
zatwierdzamy formułę.   

 

W zakładce funkcji Write podaj nazwę nowego produktu do jakiego zostanie zapisany wynik sekwencji operacji, 
wybierz format BEAM-DIMAP i wskaż folder w jakim produkt ma zostać zapisany. 

 

Zapisz sekwencję przetwarzania przyciskiem Save, znajdującym się w dolnej części okna funkcji Graph Builder.  

Uwaga!!! Ze względu na błąd w SNAP należy przed uruchomieniem obliczeń ponownie uzupełnić w niej 
parametry dotyczące odwzorowania i siatki i uruchomić obliczenia nie przechodząc już do innych zakładek. 

Przyciskiem Run uruchom przetwarzanie danych. Po przetworzeniu danych w oknie Product Explorer zostanie 
automatycznie załadowany wynikowy produkt, który powinien zawierać tylko jeden raster – obliczone wartości 
SST w °C z wymaskowanym obszarem lądu i chmur. 

Zapisany graf można uruchomić dla dowolnej sceny zmieniając jedynie parametry funkcji Input-Output. Można 
też wykorzystać dla wielu scen jednocześnie w funkcji Tools>Batch Processing, która automatycznie dostosuje 
parametry funkcji Input-Output (w tym przypadku graf należałoby zmodyfikować pomijając funkcję Subset, gdyż 
obszar zainteresowania w zależności od nr orbity może być w innej części ścieżki). 

PORÓWNANIE WIZUALNE 

Wyświetl rastry SST_C z obu przetworzonych scen. Mapy w oknie wyświetlania oznaczone są nazwą rastra oraz 
nr produktu (nr w nawiasach []), z którego danych raster został wczytany - zgodnie z numerami produktów 
w oknie Product Explorer. Aby wyświetlić mapy obok siebie wybierz odpowiedni układ okienek z paska narzędzi. 
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Mapy łatwiej porównywać, jeśli wyświetlane są w tej samej palecie barw. Aby skopiować paletę zastosowaną 
wcześniej do mapy z godzin wieczornych uaktywnij tą mapę (klikając w zakładkę z odpowiednim nr produktu – 
pojawi się żółta obwódka mapy). W oknie Colour Manipulation widoczna jest zastosowana skala barw.  Przycisk 
Apply to other bands w prawym górnym rogu tego okna pozwala zastosować tą samą paletę do wybranych 
rastrów. 

  

Zaznacz raster [#]SST_C (# - nr produktu zawierającego dane poranne) i zatwierdź przyciskiem OK. Pojawi się 
pytanie czy skala barw ma zostać automatycznie rozciągnięta do zakresu wartości w wybranych rastrach. Aby 
zachować zdefiniowany wcześniej rozkład znaczników od 0 do 20 co 2,5°C wciśnij No. 

W oknie Navigation znajdują się opcje synchronizacji powiększenia obszaru w obu mapach (zaznaczone ) 

oraz synchronicznego śledzenia pozycji wskazywanej kursorem na obu mapach (zaznaczone  ). 

 

ANALIZA PORÓWNAWCZA 

W menu, w opcji Analysis znajduje się kilka funkcji, które można wykorzystać do szybkiego porównania danych z 
dwóch rastrów. Scatter Plot tworzy wykres zależności wartości jednego rastra od drugiego. Piksele zawierające 
kod braku danych na jednym lub obu rastrach nie są brane pod uwagę w analizie. 

W polach definiujących oś X wybierz produkt zawierający dane ze senny porannej, a następnie raster SST_C. Na 
osi Y wybierz produkt zawierający dane ze sceny wieczornej i analogicznie raster SST_C. Uruchom przycisk 
Refresh View.  

Klikając prawym klawiszem w obszarze wykresu można np. przejść do opcji wyglądu wykresu (Properties) 
i dostosować opisy osi, wykresu itp., zapisać wykres w formacie pliku graficznego (Save as…) lub skopiować dane 
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tworzące wykres (Copy Data to Clipboard), aby wkleić je do arkusza kalkulacyjnego lub innego programu w celu 
obliczenia współczynnika korelacji lub dopasowania funkcji regresji. 

 

Funkcja Analysis > Statistics pozwala na utworzenie histogramu oraz policzenie podstawowych statystyk (piksele 
oznaczone kodem braku danych nie są brane pod uwagę w analizie). Po wywołaniu funkcji należy kliknąć na okno 
mapy dla której mają być liczone statystyki, a następnie w oknie funkcji przycisk Refresh View. Klikając prawym 
klawiszem w obszarze wykresu można np. przejść do opcji wyglądu wykresu (Properties) i dostosować opisy osi, 
wykresu itp. albo zapisać wykres w formacie pliku graficznego (Save as…). Aby skopiować wyniki obliczeń należy 
kliknąć prawym klawiszem na tabeli statystyk i wybrać Copy Data to Clipboard.  

 

Tworząc mapę różnic w kalkulatorze rastrowym (Raster > Band Maths) w edytorze wyrażenia (Band Maths 
Expression Editor) przed wyborem rastra należy wskazać produkt, z którego ma być wybrany. W formule nazwa 
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rastra poprzedzona będzie symbolem $#., gdzie # nr produktu, z którego danych raster został wczytany - zgodnie 
z numerami produktów w oknie Product Explorer. 

 

 

INTERPRETACJA DANYCH – POTENCJALNE PROBLEMY 

Standardowe algorytmy nie zawsze poprawnie identyfikują obszary zachmurzone. Efekt „niedomaskowania” 
chmur może pojawić się w rejonach, gdzie zachmurzenie nie jest pełne lub na obrzeżach chmur.  Wartości SST 
obliczone z zastosowaniem jednego „spojrzenia” (rejestracja nadirowa) w takich przypadkach są mocno 
zaniżone. Przy zastosowaniu algorytmu SST opartego na podwójnym „spojrzeniu” (rejestracja nadirowa i ukośna) 
wartości mogą być zarówno mocno zaniżone, jak i zawyżone. Informacja na temat algorytmu przetwarzania dla 
każdego piksela zawarta jest w rastrze Bands > sst_algorithm_type, a opis poszczególnych wartości w tabeli 
Index Codings > sst_algorithm_type. 

   

Odwrotny efekt, tj. identyfikacja obszarów niezachmurzonych jako zachmurzone („przemaskowanie”) występuje 
często w obszarach silnych gradientów temperatury, np. w rejonie rozpływu wód rzecznych lub zimnych wód 
wyniesionych na powierzchnię w wyniku upwellingu, a także w strefie przybrzeżnej. 

L2 SST L1 QUICK-LOOK 

obszar zachmurzony 
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Innym problemem w interpretacji satelitarnych map temperatury są tzw. efekty naskórkowe. Promieniowanie 
termalne, emitowane z powierzchni morza powiązane jest z temperaturą warstwy naskórkowej, o grubości ok. 
10 µm. Warstwa ta w ciągu dnia przy dużym nasłonecznieniu i słabym wietrze nagrzewa się bardzo silnie, co na 
satelitarnych mapach widoczne jest w postaci plam cieplejszych wód (hot-spot). Efekt ten maleje szybko 
z głębokością, stąd porównanie wartości temperatury powierzchniowej uzyskanej z danych satelitarnych (skin 
temperature) z pomiarami in situ (bulk temperature mierzona przeważnie na głębokości ok. 0,5-1,0 m) wskazuje 
zawyżenie temperatury, które w skrajnych warunkach (w godzinach południowych, przy wietrze poniżej 2 m/s 
i dużym nasłonecznieniu) może dochodzić do 2-3°C. Cechą charakterystyczną hot-spotów jest ich szybkie 
zanikanie w godzinach wieczornych, stąd w analizie zmian temperatury w dłuższym okresie wykorzystuje się 
przeważnie rejestracje wieczorne. W nocy przy bezwietrznej pogodzie warstwa naskórkowa wychładza się 
szybciej niż głębsze warstwy, co prowadzi do zaniżenia wartości w stosunku do in situ, ale różnice są mniejsze – 
przeważnie do 0,5°C. 

  

 

PODSUMOWANIE 

W materiałach przedstawiono źródła danych Sentinel-3 / SLSTR, strukturę pobranych plików i podstawowe 
funkcje programu SNAP pozwalające na przygotowanie wizualizacji mapy temperatury, a także eksportu danych 
do pracy w GIS. Zaprezentowano również sposób automatyzacji wstępnego przetwarzania danych oraz funkcje 
analizy, które mogą posłużyć do porównania danych z różnych zobrazowań. 

  

L2 SST L2 SST z maską chmur 

„przemaskowanie” upwelling przybrzeżny 

2020-08-16 9:52 UTC 
S3A 

2020-08-16 20:44 UTC 
S3B 
 

hot-spot 
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